
Workshop: Introduction to Actions 
(notes by Ron Addison) 

If you desire to organize your workflow, create special effects with images and text, or 

repeat steps you often make, then action should be of interest.  Actions are similar to macros in 

a word processing program.  In other words, an action is a recorded series of steps that were 

taken in Photoshop®.  For example an action could place a wood frame around your picture.  (See 

Appendix 1 for descriptions of actions on the “Workshop Disk.” That action could be used to 

place a wood frame around any similar image.  This is why actions are so powerful.  Adding to 

this power is the ability of an action to be applied to a folder of files by applying actions as part 

of a batch process.   Because actions are so powerful, you should only apply an action to a copy 

of your image.  Actions often make changes to your file that can’t be reversed. 

Actions have been available since Photoshop 4 was released.  There were ways to “cheat” 

and use actions in early versions of Elements.  In Elements 6 and 7, it became relatively easy to 

run an action.  However, actions may only be written in Photoshop.  Elements cannot run every 

action written in Photoshop.  Surprisingly, Elements can run some actions that contain commands 

that are not available in Elements.  This shows that some Photoshop commands are hidden from 

the user in Elements.  When a new version of Elements is released these “unsupported” 

commands may disappear. 

One great feature of actions is that they are “cross-platform.”  An action recorded on a 

Mac will run without any changes on a PC.  Actions are saved by Photoshop as an “.atn” file.  The 

action palette will help you load an action from the Workshop Disk or one you have downloaded 

from the internet1.  However, Elements requires you to copy the files on the Disk or downloaded 

into a special file.  This special file varies from version 6 to version 7 and version 8.  After 

moving your actions to the proper location, you must force Elements to reconstruct its database 
                                                            
1 Actions Central is a good place to download actions. 
http://www.atncentral.com/download.htm 
Adobe cfusion/exchange  has 1,000s of actions. 
http://www.adobe.com/cfusion/exchange/index.cfm?event=productHome&exc=16&loc=en_us  
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file.  The database file tells Elements what actions, gradients, etc. are available.  If the 

database file is deleted, Elements will rebuild the database when it is started.  You can get a 

cup or two of coffee while the file rebuilds.  Detailed instructions are on the Disk in the 

Elements folder.  Look at the pdf file “Installing_...” for your version of Elements.  Also, details 

about how to install actions in Elements can be found at: 

http://graphicssoft.about.com/od/pselements/qt/actions.htm  

The June 2009 issue of Shutterbug magazine has a detailed article on actions.  On the 

disk, I have included the action from that issue called Joes.atn in the CS-other folder.  This 

action only runs in Photoshop CS.  This action converts a color photograph to black and white 

and then adds a soft focus. 

On the Disk in the Elements folder, I have placed the folder “Copyright for Elements.”  I 

recorded this action in Photoshop CS4.   The copyright action should be run on an image that 

only has one layer named background..  The action will place a generic copyright © notice in the 

lower left hand corner of the image.  If you use only Elements and you would like to use this 

action to place your copyright on an image, please just send me an e-mail including exactly the 

way you want your name.  I will send you the action and the associated files that will run in 

Elements.  If you can use Photoshop, you can load the action into Photoshop.  Then use click on 

the Type Layer and place your name in the action.  Appendix 2 has a detailed description of the 

copyright action. 

Files on the WORKSHOP DISK: 

• Actions for Elements 

All of the actions for Elements listed in Appendix 1 

Directions for installing the actions in each version of Elements. 
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• CS-PanosFX 

All of the actions for Photoshop listed in Appendix 1 

• CS-Other Actions 
 
Actions downloaded from the internet. 
Many of folders have txt files describing how the action works. 
Some have images before and after the action was run. 

• Copyright for Elements 
 
This action runs in Photoshop. 
The action and associated files can be placed in the proper Elements folder.   
Then the action will run in Elements 6 or 7. 

• WORKSHOP: Intro to Actions.doc & WORKSHOP: Intro to Actions.pdf 

• Examples of Photoshop Actions.exe 
 
This is the ProShow Gold presentation given at the Workshop. 



Workshop: Appendix 2 
All actions are from PanosFX.com where examples are available 

25 MATRIX 
Elements 6, 7 Photoshop 6 and higher 

Just released as part of the Big Pictures 
download.  The Matrix Collage action put 
together 25 different photos into one image.  
Each of the images in the Collage is on a 
separate layer.  Therefore, you can move the 
photos and/or rotate them. 

This action lets you combine 25 images of your 
choice on a 5x5 matrix. Each photo is placed on 
its own, individual layer. (A detailed 
readme.txt file is included in the .zip set). 
Load your 25 images and press play. All images 
must be of the same size. I strongly 
recommend you copy all images into a new 
folder and downsize them; the final image will 
be 25 times bigger than each one of its 
components! You can load them one by one (the 
first image you load will be the first in the 
first row, etc). You can also batch open them 
(in Windows click on the last image, hold down 
SHIFT key and click on the first image and 
them press open). 

B&B 
Elements 3, 4, 5, 6, 7 Photoshop  6 and higher 

The name B&B derives from the bordering and 
bending routines used to give the image the 
particular curved look. Open an image and fire 
up either the "bbconvex" or the "bbconcave" 
action. 

"B&B set of effects" is a very handy set of 
actions. It uses a number of techniques to 
give your images an impressive curled look. 
Open an image and play one of the many 
Convex, Concave and Curl actions. Do not play 
any of the subroutine actions. In addition do 
not change the filename BBeffects.atn, for 
the action will halt. 

B&B FILMSTRIP 
Elements 3, 4, 5, 6, 7 Photoshop  6 and higher 

This is a set of powerful actions that will turn 
your images into filmstrips and will give them a 
3-D look. Open an image and fire up either the 
convex or the concave action. The zip file 
contains instructions on how to install and use 
this action.  

B&B filmstrip is a set of powerful actions that 
will turn your images into filmstrips and will 
give them a 3-D look. The set includes both 
convex and concave effects. In version 2.0 I 
have also included the Reset Shear Filter 
adjustment action. The latest resolves the 
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problem of the angular filmstrip edges. The zip 
file contains 2 action sets: The BBfilmstrip 
actions are optimized for images of the 4:3 
aspect ratio. The BBFilmstrip35mm actions are 
optimized for images of the 3:2 format. 
Detailed instructions are given in the PDF 
manual that is included in the zip file. 

 
B&BIG PICTURE 

Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 
The "B&Big Picture" combines two popular 
effects:  the versatile "Big Picture" action 
with the eye-catching B&B techniques. At the 
end your image is turned to a very impressive 
collage made up by 25 different photos. Each 
one of these photos has a bordered style and 
appears to be slightly curved by moisture, 
casting a beautiful shadow on the canvas. The 
action is designed for images of landscape 
orientation! The zip file contains instructions 
on how to install this effect.  The 25 collage 
photos are actually individual layers that are 
named in a spreadsheet manner, i.e. A1, A2, 
etc. You can rotate or move sole layers or even 
linked layers, to create your own effects. 

The B&Big Picture combines two of my popular 
actions: the versatile "Big Picture" action with 
the eye-catching B&B techniques. At the end 
your image is turned to a very impressive 
collage made up by 25 different photos. Each 
one of these photos has a bordered style and 
appears to be slightly curved. The action is 
designed for landscape orientation photos! 
Load the action and press play. The 25 photos 
are actually individual layers that are named 
using a spreadsheet style, i.e. A1, A2, etc. You 
can rotate or move individual layers or even 
linked layers, to create your own effects. 
Users who have PS7 and higher will be able to 
apply some interesting perspective effects at 
the end. The action is very complex and it will 
take some time to finish playing. 
 

BIG BLUE 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

BIG BLUE creates a relaxing, imaginary marine 
world and makes your image a part of the 
scenery. This action is an example of the 
endless possibilities offered by this wonderful 
program. All you have to do is open an image 
and run the action. It will create a marine 
scenery where random clouds reflect on the 

BIG BLUE creates an oceanic scenery and 
makes your image a part of it. Clouds, 
reflections, waves are some of the decorative 
features of this complex Photoshop action. All 
you have to do is open an image and run the 
main action. It will create a sea landscape 
where random clouds reflect on the surface of 
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surface of a blue sea. The zip file contains 
instructions on how to install this effect in 
your PSE. 

a blue sea. You can then play with the color-
scheme actions, to change the time of the day 
and consequently the scenery look. 

BIG PICTURE 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

BIG PICTURE is an action that will make an 
image look as a collage made up of 25 individual 
photographs that are slightly untidy. Load a 
landscape orientation image. Run the action. 
The zip file contains instructions on how to 
install this effect.  The 25 photos are actually 
individual layers that are named in a 
spreadsheet manner, i.e. A1, A2, etc. You can 
rotate or move sole layers or even linked 
layers, to create your own effects.  

The BIG PICTURE is a Photoshop action that 
will make an image look as a collage made up of 
25 individual photographs that are in a 
'slightly untidy manner'. Load an image of 
landscape orientation. Load the action and 
press play. The 25 photos are actually 
individual layers that are named in a 
spreadsheet manner, i.e. A1, A2, etc. You can 
rotate or move sole layers or even linked 
layers, to create your own effects. 

 
 

THE BIG PICTURE EXTRAS 
 Photoshop 6 and higher 

 This is a set of four add-on effects for the 
BIG PICTURE action. First run the BIG 
PICTURE action, then try the add-on actions 
of this set. 

B&BIG PLUS 
 Photoshop 6 and higher 

 "B&Big PLUS" creates the effect you've seen 
on the B&Big picture but in this case you have 
more goodies (3 extra variations with both 
concave and convex collages, image glows, etc).  
Load a landscape image, preferably of the 3:2 
ratio. Choose among the 3 Concave & Covex 
effects and press play. If you have PS7 and 
higher you can try the 5 transformation 
effects on the action product. Do not play any 
of the 3 subroutine actions!. 

BLACK & WHITE CONVERSION AND IMAGE DESATURATION 
 Photoshop 6 and higher 
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 More control on B&W conversions and image 

desaturation. Open an image. Avoid working on 
lower compression JPGs (I recommend working 
on 16-bits images). Run the action. A duplicate 
of the original image will be created. Step 1 
Change the blending Mode to taste.  Step 2 
Check the Mask button.  Step 3 Experiment 
with different Channels.  Step 4 Fine tune the 
Opacity.  You will be prompted to change the 
"Pin Light" blending mode in the Calculations 
window (the 'Pin Light' blending mode produces 
a neutral effect similar to Photoshop's 
grayscale). Deploy the mask options and 
manipulate the mode of the 3 channels. Try 
not to pick a channel that increases the overall 
image noise. In addition, you can fine tune the 
overall effect by changing the opacity, in the 
Calculations window. Finally, when the action 
finishes you can adjust the opacity of the "BW 
layer" from 100% to 0% to manipulate the 
degree of desaturation. 
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CARVED MARBLE TEXT 
 Photoshop CS2 and higher 

 Give your text a kind of carved green marble 
look. Play the first action only (not the 
subroutines). Do not change the action file 
name or the actions will halt. Detailed 
instructions are given in the process. Use thick 
fonts @ 300 ppi. 

 
CRACKED WALL PAINTINGS 

Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 
Once upon a time someone painted a beautiful 
painting on a wall. Time passed. Everything 
decayed, and together with everything, 
decayed the painting. The Cracked Wall 
Paintings is a set of 2 actions that reproduce 
the look of a cracked, painted wall facade. Run 
the main action first. You will be given detailed 
instructions while the action runs. When the 
main action finishes playing, you can try the 
'peel off' extra effect. 

Once upon a time someone painted a beautiful 
painting on a wall. Time passed. Everything 
decayed, and together with everything, 
decayed the painting. The Cracked Wall 
Paintings is a set of Photoshop actions that 
reproduce the look of a cracked, painted wall 
facade. Open an image and run the main action. 
Then try the extra actions in order to add 
extra aging effects. Before starting, run the 
README1st action and print the instructions. 

DECK 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

The DECK action lets you recreate a popular 
framing effect within seconds. Your image 
appears to be on top of a stack of photos. The 
set contains 4 actions. Two of them are 
optimized for landscape layout images of 4:3 
ratio while the other two are optimized for 
portrait images.  Each one of these pairs 
contains 2 different effects.  Load an image 
and run any of the four DECK actions. 

The DECK is a Photoshop action that lets you 
recreate a popular framing effect within 
seconds. Your image appears to be on top of a 
stack of photos. I named this action after the 
look of the cards of a deck. The zip file 
contains 2 different sets of actions optimized 
for portrait and landscape layout images 
respectively. The steps you have to take are 
the same for both sets: 1. Open an image 2. 
Run one of the "Plain photo" or the "Bordered 
Photo" actions 3. When the action finishes 
playing run any of the 3 effect actions to 
change the look of the subjacent photos. As 
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with all my actions, all layers are left intact at 
the end. 

DISCRETE 
 Photoshop 6 and higher 

 The 'Discrete' actions give you another 
interesting tool to make your images visually 
more appealing. What is also interesting about 
this set is that the actions make use of smart 
filters. Therefore CS3 users will be able to 
readjust the amount of blur on the shadow, 
when the action finishes. The actions give you 
the option to modify a number of different 
visual elements to preference. The action has 
two versions. Run one of the two actions. You 
will be asked to open an image in the process. 

EDGE EFFECTS 
 Photoshop 6 and higher 

 8 actions that create a variety of edge 
effects. For more details read the tutorial on 
this site. A PDF manual is included in the set. 

EMBOSSED LABELS 
Elements 3, 4, 5, 6, 7 Photoshop CS and higher 

These actions simulate realistically the popular 
look of an embossed label tape. Just type in 
your text and let Elements punch the letters 
on the tape. You can choose from three tape 
colors (R-G-B). You have to have an existing 
image open prior to running this effect. The 
action won't manipulate this image; it will 
create a new document from scratch. 

These actions simulate realistically the popular 
look of an embossed label tape. Just type in 
your text and let Photoshop punch the letters 
on the tape. You can choose from three tape 
colors (R-G-B). Just play one of the RED / 
GREEN/ BLUE actions. 

EMPHASIS 
 Photoshop 6 and higher 

 This set contains two effects: The WHITE 
BORDER effect faints the photo and 
emphasizes a rectangular area (whose 
boundaries are defined by you) by turning it 
into a color photo with a white border. The 
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HEART effect emphasizes the center of your 
image by making it appearing within a beveled 
heart. The area outside the heart is fainted 
and given a red hue. Ideal for romantic 
compositions! Open an image and play one of 
the two actions of the set. 

FAN 
Elements 4, 5, 6, and 7 Photoshop 7 and higher 

The zip file contains 4 different folders that 
contain the necessary files for PSE 4, 5, 6, 7, 
respectively. 

This is a complex Photoshop action that will 
create a hand-held fan using one of your 
images. Make sure you run the action on images 
of landscape orientation. The action creates 
20 slats and adds a number of decorative 
elements, making use of semi-transparent 
layers. In addition to the main effect, the 
action creates another two interesting 
perspectives. The action will ask you to open an 
image of landscape orientation. The rest is 
done automatically. 

GREEK RODAX FRAME 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

The action will decorate your images with a 
golden frame inspired by ancient Greek art. 
The inner frame depicts a "meander" pattern 
while the outter frame is made up by "Rodax" 
flowers. Both motifs were widely used in 
ancient Greek pottery and sculpture. Open an 
image and run the action. The actions are 
optimized for landscape orientation images. By 
default the frame style is optimized for large 
images (however you are given the option to 
scale up/down the effects). 

This action will frame your image with a 
beautiful motif that was widely used in ancient 
Greek art, the Rodax. Load an image of 
landscape orientation. Load the action set (it 
will take a few seconds). Play one of the first 2 
core actions (they create large / small rodax 
frames). Then you can play the other 5 actions 
to make the effect more impressive. These 5 
actions include the "golden" frame, the "Greek 
blue" frame and 3 B/W versions. 

HIGH PASS SHARPENING 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

Sharpening photos using Elements' high-pass 
filter and layer blending is a great method: It 
is easy, customizable and more important it is 

Sharpening photos using Photoshop's high-pass 
filter and layer blending is a great method: It 
is easy, customizable and more important, it is 
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fully reversible. This action does the trick in 
seconds. Open an image and double click the 
action. At the end adjust the opacity of the 
"Sharpening layer" to manipulate the strength 
of the effect. 

fully reversible. This action does the trick in 
seconds. Open an image and press play. At the 
end adjust the opacity of the "Sharpening 
layer" to manipulate the strength of the 
effect. 

MEANDER FRAME 
 Photoshop 6 and higher 

 this action will decorate your image with a 
classic ancient Greek motif, the meander.  
The meander is thought to represent the 
course of the river Meandros in Asia minor; it 
had a deep symbolization for ancient Greeks, 
representing the course of our life. Open an 
landscape orientation image and press play. 
The frame styles are optimized for large 
images but you can tweak them to preference. 

MOIVE FILM 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

This combines 4 landscape layout images to 
create a movie-camera filmstrip. On the left 
film edge the script creates the sound 
waveforms stripe. The actions are optimized 
for landscape layout images of 4:3 ratio. Load 
an image and run the MAIN EFFECT action 
first. Then run any of the "To change look" 
actions to change the film look. 

This combines 4 landscape layout images to 
create a movie-camera filmstrip. On the left 
film edge the action creates the sound 
waveform stripe.  The action gives you the 
option to type your own text on the right film 
edge. Finally you can choose from four 
different filmstrip variations. Please run the 
MAIN ACTION first. Then run any of the 
"Alternative look" actions to change the film 
look. Finally run the "Add text" action to type 
your text on the right film edge. 

OUT OF BOUNDS PLUS 
Elements 5, 6, 7 Photoshop CS2 and higher 

The OoB+ (Out of Bounds plus) is an advanced 
tool which simplifies the steps needed to 
create the impressive and popular OoB 
effects.  The action is very flexible; at the 
beginning it lets you define the area of the 
photo and its shape; it then lets you define the 

The OoB+ (Out of Bounds plus) is an advanced 
tool which simplifies the steps needed to 
create the impressive and popular OoB 
effects.  The action is very flexible; at the 
beginning it lets you define the area of the 
photo and its shape; it then lets you define the 
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size of the white border; in the next step you 
define the out-of-bounds areas. The action 
makes use of layer masks and this allows you to 
edit the final effect at the end. 
There is a new version on the Workshop Disk 
in the Elements folder.  Action is titled 
PanosFX_OoB_PSE. 

size of the white border; in the next steps you 
define the out-of-bounds areas and you add 
the shadow effects. The action makes use of 
layer masks and this allows you to edit the 
final effect at a later stage.  (VIDEO 
TUTORIAL)  There is a new version on the 
Workshop Disk in the CS-PanosFX folder.  
Action is titled PanosFX_OoB. 

3D OUT OF BOUNDS 
 Photoshop 6 and higher 

 This action gives you the necessary tools to 
create an effect which can be extremely 
useful to those who want to emphasize a part 
of the photo, such as a product etc.  
Overall, it creates a polaroid type of frame, 
where an object appears to pop out of the 
photo. 
 
Bear in mind that this is not a press play-and-
go procedure; you will need to apply your 
selection-making skills using the appropriate 
Photoshop tools.  Remember: Start with the 
right photo (it should depict one object with 
clear lines, that dominates the picture); try it 
on a train, truck of even an aircraft photo for 
a start! 

PAGE CURLS 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

This action lets you create your own impressive 
and highly customizable page curl on any image 
corner. 

This action lets you create your own impressive 
and highly customizable page curl on any image 
corner. 

PAPER CUBE MAP 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

This action lets you print up to 5 photos on a 
cube. You have to have an existing image open 
prior to running this effect.  The action won't 
manipulate this image; it will create a new 

This action lets you print up to 5 photos on a 
cube. You can print images of you beloved 
people (your spouse, kids, grandkids, friends). 
There are 2 actions in the set. The first 
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document from scratch.  There are 2 actions 
in the set. The first creates a cube that has 
the same photo printed on each side. The 
second action prints 5 images (one on each side 
- the cube base is blank). Once you run the 
actions, a cube map will be created.  Print it on 
a photo paper.  Cut precisely along the edges. 
Fold firmly the cube sides, then the wings. 
Finally apply some glue on the wings and stick, 
or use a double-sided mount tape. 

creates a cube that has the same photo 
printed on each side. The second action prints 
5 images (one on each side - the cube base is 
blank). Once you run the actions, a cube map 
will be created. Print it on a photo paper. Pick 
up a scissors. Cut precisely along the edges. 
Fold firmly the cube sides, then the wings. 
Finally apply some glue on the wings and stick, 
or use a double-sided mount tape. Crop the 
images to 747px x 747px @ 300ppi, save them 
and run the actions. 

PHOTOALBUM 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

This action will create a picture book from 
scratch and will place your photo on its front 
page. The action creates a number of items, 
such as binding rings, tape holders, multiple 
pages. Press play and have fun!!! The action is 
optimized for images of landscape orientation. 

This action will create a picture book and will 
place your photo on its front page. Open a 
landscape image and press play. In rare cases 
Photoshop's Share filter behaves abnormally 
and you may get an angular curve or experience 
execution errors. In this case please run the 
Reset Share Filter action which is included. 

PHOTRIS 
 Photoshop 6 and higher 

 Photris will give your image a tiled look. 
Similarly to Puzzle Effects, in Photris each 
piece is an individual layer. This is very handy 
to those who want to move pieces or groups of 
pieces in order to create their own effects. In 
order to identify and select the respective 
piece-layer you will have to right-click on it. 
Load an image of landscape orientation. Load 
the action set and run the core action. Then 
run one of the 4 effect actions to change the 
look of the pieces. 

PLASMA TV 
Elements 3, 4, 5, 6, 7 Photoshop CS and higher 

Plasma TV is a set of 3 actions that create an 
impressive and complex framing effect.  At 

The Plasma TV action places your image in a 
Plasma TV screen. A number of elements such 
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the end of the action your image will appear on 
a Plasma TV screen. A number of elements 
such as speakers, buttons, etc. are added to 
enhance the overall impression. The final 
product consists of a considerable number of 
layers that are left intact for you to 
manipulate.  Open an image and run the Plasma 
TV action first. Then run one of the speakers 
actions. The actions are optimized for 
landscape images. 

as speakers, buttons, etc. are added to 
enhance the overall impression. The final 
product consists of a considerable number of 
layers that are left intact for you to 
manipulate. The actions are optimized for 
landscape images of 3:2 and 4:3 aspect ratio. I 
have included a detailed PDF manual that 
explains the way the action works. 
Additionally, a number of instruction stops will 
guide you through while the action is running. 
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PUZZLE EFFECTS 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

This is a set of 18 actions that create jigsaw 
puzzle effects. There are 6 main actions that 
create jigsaws with 4, 6, 20, 30, 56 and 100 
pieces respectively. 
Each one of these actions comes in three 
versions, that create thin, normal and thick 
pieces edges. The actions are optimized for 
landscape orientation images, of the popular 
4:3 aspect ratio.  With small images use the 
thin edges actions. With normal or large 
images use the normal edges or the thick 
edges actions respectively. 

The free version contains 2 jigsaw actions that 
create 6 and 20 pieces. The actions are 
optimized for landscape layout images. On 
portrait images simply rotate by 90 degrees 
first. Then play any of the 6 puzzle actions. 
You may want to read the two tutorials which 
present some very useful tips about the puzzle 
actions. 
 

RAINY DAY 
Elements 5, 6, and 7 Photoshop CS and higher 

It is a cloudy day, the sky is moody. The rain 
started falling. You can hear the raindrops 
tapping and see them rolling down your clouded 
window glass.  RAINY DAY is a set of actions 
that will make your images look as if they are 
seen through the window while it rains.  The 
set contains two actions (PART1 and PART2). 
Rainy Day Part1 should be applied first. It will 
create the raindrops. Rainy Day Part2 is 
optional. It lets you apply a condensed steam 
effect.  The actions will work with images of 
any size. However keep in mind that they are 
optimized for images around 3 Megapixels. 
I've added a couple of instruction stops that 
help you tailor the effect to fit (slightly) 
smaller or bigger images.  You will produce 
more interesting results if you try the actions 
on a moody landscape picture. 

It is a cloudy day, the sky is moody. The rain 
started falling. You can hear the raindrops 
tapping and see them rolling down your clouded 
window glass.  
The RAINY DAY is a set of Photoshop actions 
that will make your images look as if they are 
seen through the window while it rains. I 
suggest you run the README action at first. 
Open an image before running the actions. The 
actions will work with images of any size. 
However keep in mind that they are optimized 
for LARGE photos (> 3 Megapixels). You will 
produce more interesting results if you try the 
actions on pictures of cloudy, moody 
landscapes. Run the MAIN ACTION first. You 
will be guided by instruction stops, while the 
action is running. These stops let you also 
control the various filters that are applied.  
Apart from the main action there are two 
extra actions that let you add a layer of 
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smaller drops and a layer of condensed vapour. 
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RULE OF THIRDS CROPPING 
Elements 6 & 7 Photoshop CS and higher 

Just Released--- Rule of Thirds Cropping for 
Photoshop® Elements. 
 
On your disk is also a Rule of Thirds from 
Shutterfreaks.com which works for any 
version of Elements before version 7.   
(SFRuleOfThirdsxxx) 

While Photoshop's crop tool is very flexible, 
things may become tricky when you want to 
crop and at the same time apply the rule of 
thirds. Here is a tool designed to make your 
life easier. It allows you to crop and even crop 
& straighten in accordance to this aesthetic 
rule. Open an image in Photoshop. Load and run 
the action. Use your mouse to move / rotate / 
resize the yellow grid layer, which represents 
the cropping area. Double click to confirm and 
the action will do the rest. Please refer to the 
PDF document inside the zip file to read some 
useful tips. 

RUBIK'S CUBE 
Elements 3, 4, 5, 6, 7 Photoshop CS and higher 

This action will use one of your images to 
create an impressive cube.  The final cube 
dimensions are fixed (842 x 910 pixels). Crop 
an image to square dimensions, save it and run 
the action. 

This action will use one of your images to 
create an impressive cube. The final cube 
dimensions are fixed (842 x 910 pixels). Crop 
an image to square dimensions, save it and run 
the action. 

SCROLL 
Elements 3, 4, 5, 6, 7 Photoshop 7 and higher 

This action creates a beautiful scroll from 
scratch. You have to have an existing image 
open prior to running this effect. The action 
won't manipulate this image; it will create a 
new document from scratch 

This action creates a beautiful scroll from 
scratch. Load the action and press play.  
Photoshop will do the rest. 

SNOW GLOBE 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

SNOW GLOBE creates a complex composition 
that comprises of many different parts: at 
first your image is decorated with a wooden 
frame. Then it is placed inside a snow globe. A 
number of different elements, such as two 

SNOW GLOBE creates a complex composition 
that comprises of many different parts: at 
first your image is decorated with a wooden 
frame. Then it is placed inside a snow globe. A 
number of different elements, such as two 
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snow layers, large snowflakes, ice, reflections, 
and many more are added to complete the 
scenery!  The action is strictly designed for 
images of landscape orientation. 

snow layers, large snowflakes, ice, reflections, 
and many more are added to complete the 
scenery!  The action is strictly designed for 
images of landscape orientation. 

SNOWED TEXT 
 Photoshop  6 and higher 

 This action will cover your text with snow and 
its edges with frost. You can customize the 
amounts of frost and snow. Follow very 
carefully the instructions that are given while 
the action is running. Change the color overlay 
and texture, and you will get a dusted cookie 
look, instead! 

SNOW WHITE TEXT 
Elements 3, 4, 5, 6, 7 Photoshop CS and higher 

The "Snow White Text" is a funny Elements 
action that will add snow and ice on your text. 
The final document is quite large in size. If you 
use the maximum text length the final 
document's width will be 10 inches @ 300 ppi.  
You have to have an existing image open prior 
to running this effect. The action won't 
manipulate this image; it will create a new 
document from scratch.   

The "Snow White Text" is a funny Photoshop  
action that will add snow and ice on your text. 
The final document is quite large in size. If you 
use the maximum text length the final 
document's width will be 10 inches @ 300 ppi. 
The fully customized action output allows you 
to create a few different effects. You can 
manipulate the text color etc. at the end, since 
all layers are left intact. 

 
 

SPIRAL BIND 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

In the zip file you will find 14 actions and their 
PSD thumbnails. There are 7 actions optimized 
for landscape orientation photos and 7 actions 
that are optimized for portrait orientation 
ones.  Each action creates a fixed width image. 
For example the 400 pixels landscape action 
should be run on a small image whose width is 
around 400 pixels. The action will first resize 
the image width to 400 pixels and will then 

These actions make the creation of a spiral 
binding effect a very easy task! In the zip file 
you will find two sets of actions: one set is 
optimized for landscape orientation photos and 
one set is optimized for portrait orientation 
ones.  
So, depending on the orientation of your 
original image, load the proper actions and 
press play! Each set contains 8 actions: The 
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create the effect. Another example: Let's say 
you have a photo whose size is 2272x1704 
pixels. You should run the 2500 pixels-
landscape orientation action with this image. 

first 7 actions resize the original image to a 
preset size before running the effect. These 
actions were created for those who find it 
difficult to scale the spiral style effects, when 
the action finishes. Find the action whose 
name is closer to the width of your original 
image and press play! The last action does not 
resize the original photo. It merely lets you 
tailor the style effect details to optimize the 
effect to the size of your image. 

SPRING PETALS 
 Photoshop CS2 and higher 

 The SPRING PETALS is a set of four framing 
actions, inspired by the flowers and colors of 
springtime.  Overall there are four different 
effects. The actions will work with images of 
any size and orientation. The result is optimum 
when the actions are played on a square image 
(its width is equal to its height).  
You can press C to select the crop tool and 
then drag with your mouse while holding the 
SHIFT key down. This trick allows you to crop 
a square image area. 

SPROCKET FEED 
 Photoshop 6 and higher 

 This action will frame your image with a 
distinctive sprocket holes type of frame. The 
action is optimized for landscape images. Open 
an image and run the action. You can adjust the 
border layer style to your liking. 

STAMP 
Elements 3, 4, 5, 6, 7 Photoshop CS2 and higher 

The Stamp action will turn your image into a 
nice stamp. Press play and have fun!!! Open an 
image and run the action. The action is 
optimized for images of landscape orientation. 

This set of Photoshop actions will turn your 
photos into great postage stamps.  The free 
version  includes 2 different postmarks (date 
is customizable). 
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SYNTHESIS 
Elements 3, 4, 5, 6, 7 Photoshop 6 and higher 

This action creates a classic photocollage 
effect. You can put together up to 18 
individual photos to create a larger image 
synthesis. Each one of these 'photos' is 
actually a part of your original image. The 
actions are strictly designed for landscape 
layout images of the popular 4:3 ratio format. 
If you want to create a collage of LESS than 
18 photos you should wait for the action to 
finish first and then discard the extra layers-
photos. 

This action creates a classic photocollage 
effect. You can put together up to 18 
individual photos to create a larger image 
synthesis. Each one of these 'photos' is 
actually a part of your original image. The 
actions are strictly designed for landscape 
layout images of the popular 4:3 ratio format. 
Please run the Readme1st action at first.  The 
'Fully Customized" action gives you full control 
over the look of the final product (i.e. the size 
of the photos, their position on the canvas, the 
rotation, the border thickness and more).  The 
"Preset layout" action creates a predefined 
layout. 

TILE EFFECTS 
 Photoshop 6 and higher 

 Give your images an alternative, tiled look with 
this set of actions. The set will work best with 
medium and large size images. Best results are 
achieved with square images. There are 6 
effects:  100 Tiles, 25 Tiles, Quadrants, 
Tetris, Sigma, Bricks.  Enjoy! Open an image 
and play any of the set's 6 actions. 

VIDEO WALL 
 Photoshop 6 and higher 

 This action will make your image appear within 
a 16 monitors video wall. A number of extra 
touches such as speakers, reflections, buttons, 
screen scanlines add to realism. The actions 
are written in such a way that allows you to 
have a great degree of control over the look of 
the final product. Run the "SCANLINES 
pattern" action first. Then open an image and 
run the "VIDEOWALL by Panos" action. Don't 
forget to select the scanline pattern when you 
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are prompted to do so. The default settings 
are optimum for 1280x960pixels. I have 
included an action that allows you to upscale / 
downscale the style effects at the end, with 
larger or smaller images. 

WRISTWATCH 
Elements 5, 6, and 7 Photoshop CS and higher 

This complex effect creates a beautiful 
wristwatch from scratch! The set contains two 
actions:  The first action creates the 
wristwatch and the second lets you add a 
photo on the watch face.  You can freely 
rotate the 3 hands.  You can also change the 2 
logos on the watch face.  The second action 
lets you add a photo to the watch face.  And, 
what is also important, all layers are left intact 
for you, to experiment with and bring the 
effect closer to preference. 

This complex effect creates a beautiful 
wristwatch from scratch! The set contains two 
actions: The first action creates the 
wristwatch and the second lets you add a 
photo on the watch face. Run the Create the 
watch action first. The action gives you great 
control on a number of features. You can 
freely rotate the 3 clock hands to preference. 
You can also change the 2 logos on the watch 
face. And, what is also important, all layers are 
left intact for you, to experiment with and 
bring the effect closer to preference. 

WEAVE IT! 
 Photoshop CS2 and higher 

 This little action lets you apply the classic 
weave effect on your images. Actually, there is 
much more in it than the weaving effect! By 
customizing the weaving size and texture you 
can create endless combinations. You must play 
the pattern generator action first. Then load 
an image and play the weaving 
action. Carefully follow the instructions given 
in the process. 
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There are additional free actions for Photoshop on the Workshop Disk in the CS-Other folder.  
These were downloaded from the Web.  While I have not written out description of these 
actions,  many contain text files describing the action and/or images before and after the 
action was run.  
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The action “Copyright for Elements” was inspired by Tim Grey’s answer 
to the following question: 

“Recently I looked at a book of photographs all shot by the same 
photographer and noticed that every image had a copyright notice on the 
bottom right-hand corner of the photographs. Is there a way to batch 
process a copyright notice onto all your own photographs? Doing each one 
by hand is very tedious and time consuming.” 

 

I have rewritten Mr. Grey’s answer to show the recording in short 
steps.  Tim Grey has made a youtube video to answer this question.  
Please take time to view the video.  Also read the note at the end of 
this article on how to join Mr. Grey’s answers to questions.  
www.youtube.com/timgreyvideos. 

1. The first step is to create an action that performs the necessary tasks. 
1.1. go to the Actions panel (choose Window > Actions if it isn't visible) 
1.2. select or add a set (folder) to contain the action (in Photoshop action 

must be a member of a set. 
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1.3. click the “Create a New Action” button (the blank sheet of paper 
icon) at the bottom of the Actions panel to bring up the New Action 
dialog box.  

 
1.4. Type a meaningful name for the action, and  
1.5. click Record to start recording the action.  

 
1.6. Open a sample image to use as the basis of creating the action 
1.7. choose the Type tool, set the appropriate attributes on the Options 

bar (font, text color, etc) 
1.8. click in the image 
1.9. type the desired text.  (NOTE: the copyright symbol is created by 

holding down the Alt key and typing 0169 on the numeric keypad. 
On a laptop, you may not have a numeric keypad.  There are at least 
two alternatives.  One press and hold down the Alt and Fn keys and 
type the little blue numbers on the m, j, o, and 9 keys in that order.  
Or if that does not work go to Start>All 
Programs>Accessories>System Tools>Character Map.  Select the 
copyright symbol © (sixth row-fourth column) and  
copy (Ctrl-C)and paste (Ctrl-V) the symbol to the desired location 

2. Position the text any place on the image. 
2.1. choose the Move tool. 

2.2. At this point you might also want 
to click the "fx" button at the 
bottom of the Layers panel and 
choose Stroke (or another layer 
style) to add a style that will help 
ensure the text is legible against 
a variety of different 
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backgrounds.  
    

2.3. Then, with the type layer active on the Layers panel, hold the Shift 
key and click the Background image layer so both are selected.  

2.4. On the Options bar (with the Move tool still active) click the 
rightmost of the three vertical alignment buttons to align the text to 
the bottom of the image  

2.5. and then click the rightmost of the three horizontal alignment 
buttons to align the text to the right of the image.  

2.6. To move the text so it isn't all the way against the edge of the image,  
2.6.1. hold the Shift key and press the up arrow button on the 

keyboard to nudge the text layer away from the bottom. 
2.6.2. hold the Shift key and press the left arrow button to nudge 

the text layer away from the right edge. 
3. Save the Action 

3.1. Choose File > Save As and save a copy of the image in the desired 
format for the action.  

3.2. Click the Stop button (the square icon) at the bottom of the Actions 
panel to stop recording. 

 
     (At this point your action is ready to apply to other images.) 

4. Batch Processing 
4.1. To apply the action in batch, choose File > Automate > Batch from the 

menu.  
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4.2. Make sure the desired action (and set) is selected from the popup at 
the top of the Batch dialog box.  

4.3. Set the Source popup to Folder, and click Choose to select the folder 
containing the images you want to process with the action.  

4.4. Turn on the Override Action "Open" Commands checkbox so the 
images in the specified folder will be processed rather than only the 
image included in the File > Open step in the action. You can turn on 
the Include All Subfolders checkbox if you want all images in all 
folders contained within the designated folder to be processed.  

4.5. Be sure to turn on both of the "Suppress" checkboxes so the action 
can run without interruption. 

4.6. Set the Destination popup to Folder, and click Choose to select (or 
add) a folder where you want the processed images placed.  

4.7. Turn on the Override Action "Save As" Commands checkbox so the 
settings in the Save As step for your action will be used as the 
settings, but the individual files being processed will be saved 
individually. You can change the File Naming settings if you'd like the 
processed images to have different names as well.  

4.8. Click OK and the images will all be processed in batch and saved in the 
destination folder you specified. 

Mr. Grey noted, “This is just one example of the power of actions, mostly 
focused on the specific issue of being able to deal with positioning text 
accurately even when processing images with different pixel dimensions and 
aspect ratios. There is, of course, much more you can do with actions to 
work incredibly efficiently in situations where the same basic tasks need to 
be applied to a series of images.” 

Again, you can view this answer as a Video Answer by visiting Mr. Grey’s 
YouTube channel at www.youtube.com/timgreyvideos.  

 


